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Introduction 

Mendeley is a free reference manager and academic social network.  

 

Mendeley provides a free online account to build a personal library of references. You can: 

• Download Mendeley Desktop for free on your own computer, and/or on the LJMU network from 

the App player (available for Windows, OSX and Linux). 

• Use mobile applications (iOS and Android) and access a web-based view of your library from any 

browser. Any updates you make are synced. 

• Organise, read & annotate your PDF documents within Mendeley.  

• Use Mendeley Desktop and the Microsoft Word Citation Plugin to insert citations using references 

from your library, and to generate bibliographies.  

 

Sign Up for Mendeley and Download the Tools 

 

Create a standard 2G storage Mendeley account at https://www.mendeley.com/.  

Adding profile information is useful for networking and recommendations features. 

 

On your own equipment.  
 

Once signed up and logged in online, click the ‘Download Mendeley’ link (pictured below) in the online 

account. From here you can access three downloads, Mendeley Desktop, Web Importer, and Citation 

Plugin for Word.  

These are all free to download. 

Start by downloading ‘Mendeley Desktop’ to your computer. 

You will be prompted to sign into Mendeley Desktop using your Mendeley online login details. Logging 

in enables you to sync changes between the online version and between different PCs (very important 

to sync to save changes always – regularly at start and end of sessions should avoid losing work and 

ensure items added online appear in the desktop version). 

Download the ‘Web Importer’ (Imports papers, web pages and other documents directly into the 

online version of your Mendeley library - available for many browsers but not Safari). 

Install the MS Word ‘Citation Plug-In’– (Enables ‘cite as you write’ using references stored in Mendeley 

Desktop). This plugin can also downloaded from Mendeley Desktop as described in the next section. 

https://www.mendeley.com/
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On the LJMU University network 

 

TIP: Using Google Chrome is easiest on the LJMU network, because Internet Explorer or Edge may try 

to open references you export from Discover and from Databases in a different programme – Endnote. 

Once you have created a Mendeley account online… 

On the LJMU app player (find pictured icon on network desktops). Search Mendeley then click on icon 

to open the Mendeley Desktop Programme.  

Use your newly created login details to sign into it.  

 

FROM Mendeley Desktop a pop-up may offer to install the MS Word plugin. If 

not, install from the Tools menu  as shown below (NOT from your online Mendeley account, as this 

does not work on the LJMU network).  

This may involve some opening and closing of MSWord/Outlook as instructed by messages on screen. 

MS Word ‘Citation Plug-In’ enables ‘cite as you write’ using references stored in Mendeley Desktop. 

 

 

If you will be using the Web Importer, install it ONLINE from the browser you are logged into using the 

‘Download Mendeley’ location shown on the previous page - Google Chrome recommended on LJMU. 

 

‘Web Importer’ (Imports papers, web pages and other documents directly into the online version of 

your Mendeley library (using Google Chrome only on LJMU network) 

N.B. It is fairly quick to do, but you have install the tools you need every time you use Mendeley on the 

LJMU student network. 

Web Importer Notes 

‘Web Importer’ is added to your Browser. See two examples here - in Google Chrome it is found to the right 

of the address bar (left), and in some others it looks like a bookmark (right). 

 

N.B. For simplicity this guide mainly describes using Google Chrome in Windows 10 rather than detailing 

slight differences for all browsers and other operating systems.        
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Set the Citation Style of your choice  

Once the Word citation Plug-in is installed find it under the References Tab in Microsoft Word, and set the 

referencing style from here as follows. 

Click the drop-down next to the word ‘Style’. 

If your style is showing in the short list, then select it. 

If your style is not showing in the list… 

You have to click ‘More Styles’ …this connects to Mendeley and a dialogue box. 

In the box – select the ‘Get more styles’ tab, then search for your style. 

Click on the required style to select . 

Click ‘Install’ then ‘Done’ (but it is still not showing). 

Use the style dropdown again – Your added style should now show in the list so click on it. 

Click ‘Use this Style’ then click ‘Done’. 

Citation style should now show in Word as pictured here. Change pic 

  

Your style should also be set in Mendeley Desktop ‘View’ menu as pictured below. 

You can always check that the correct style is selected and change styles here if not. 

 

The Harvard style pictured is one of the styles that is similar (not exact) to Harvard LJMU. A guide is 

provided by Cite Them Right (LJMU subscription resource), enabling you to check references in this style. 

‘Cite Them Right’ also covers: APA, MLA, MHRA, OSCOLA, Vancouver, Chicago, IEEE. It is vital to check 

citations and references produced by any Reference Management tool are complete and consistent in the 

details, and Mendeley is no exception.  

TIP: Good practice to methodically check the reference and make any necessary edits when you first add 

them to your Mendeley Library, so they are ‘good to go’ for your writing.. 

  

https://www.citethemrightonline.com/Home
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Adding and Editing References and Documents 

Adding an article PDF or any other PDF to Mendeley Desktop 

If you download an article from LJMU’s Discover or anywhere else, it will usually go straight to your 

downloads in Google chrome. Some PDFs have good embedded reference data. If so, once you have added 

your PDF to your Mendeley library, the item will be ready to use as a reference. 

For many PDFs you need to edit the fields to create a good reference. 

 In Mendeley Desktop, select where you want the document (Research Skills folder selected – pictured 

below).  

Click File, then ‘Add files’ OR dropdown for menu pictured below – select ‘Add files’. 

  

 

Browse to ‘Downloads’ folder, then click on PDF document to 

select it, and click ‘Open’ to add it. Image shows finding 

downloads on LJMU network, (typical for Windows 10 PC). 

 

 

 

NB. Important. In student profiles on the LJMU network the Downloads are not saved, so add files to 

Mendeley before ending your session (and SYNC), or to a folder on your Office 365 OneDrive to add later.  

 

Tip: Watch folder option in image above. You can set a folder for Mendeley to ‘watch’ – any PDF you put in 

will be added to Mendeley. Always check material type for any added PDFs, then edit fields as needed.  
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Adding Books and Journal Articles from Discover to Mendeley Desktop. 

In ‘Results’ list choose an item (BOOK in this example) to reference. Journal articles are the same process. 

 

In results list, click the Double quotes as above to see options, from which you select Endnote. 

Continue clicking the button below. Book or Journal Article material ‘Type’ should select automatically.  

 

You see the ‘Reference’ (RIS) file download in Chrome (bottom left), defaulting to go to the ‘Downloads’ 

folder. In Mendeley, use    button to add file, browse to file in ‘Downloads’ and click to confirm.  

                  

As above, a few simple edits ensure the book is ready to display correctly in citations & references.   

              

Tip:  Watch out for Editors incorrectly in the author field. Simply cut and paste to move them to correct 

field. 
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Export multiple references from Discover to Mendeley using Discover ‘Pin’ feature. 

Perform search. Use item pin to ‘Add to marked list’. (Pinned items show in yellow, and can be unpinned by 

clicking on pin again). Access the list of pinned items by clicking on the larger pin at top right. 

 

The ‘Pins’ screen opens at the first of 3 tabs - ‘Saved records’. Here, 6 items have been pinned. Tick the ‘6 

items’ box to select all items as pictured. (Or tick individual items if not all are wanted). Next click the 3 

menu dots, and complete the steps as below to download RIS file for all 6 references. Add file to Mendeley. 
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Adding Multiple References from Databases to Mendeley Desktop – Four Examples 

Many databases have the option to ‘export’ multiple references to reference managers like Mendeley. Here 

are 4 examples of exporting from multidisciplinary databases from Databases A-Z on the electronic library. 

Exporting from Wiley Online Library 

Once logged in as LJMU using A-Z instructions, perform a search. Click ‘Export citation(s)’ - a box pops up. 

 

Tick Items to export, then click ‘Next’ button at the bottom of the pop up box. 

 

In the next box select RIS for ‘Format’ and Citation file for ‘Type’ then click ‘Export’ (as below).

 

https://www.ljmu.ac.uk/microsites/library/resources/electronic-library
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You will see the ‘Reference’ (RIS) file download in Chrome, defaulting to go to the ‘Downloads’ folder. 

In Mendeley, again use    button to add file, browse to file in ‘Downloads’ and click to confirm.  

TIP : Remember to SYNC regularly when you have added references to avoid losing work or forgetting at 

the end of your session, especially when on the LJMU network. 

Exporting from Emerald Insight 

Once logged in as LJMU using A-Z instructions, perform a search. Each result has a box at it’s top left. Tick 

desired results. 4 have been ticked altogether in image including first. Click ‘download RIS’ 

 
 

You will see the ‘Reference’ (RIS) file download in Chrome, (defaulting to go to the ‘Downloads’ folder in all 

browsers). 

In Mendeley Desktop, again use button to add file, browse to file in ‘Downloads’ and click 

open to confirm and add references.   

Exporting from Ebsco Databases  

Includes Business Source Complete, Education Research complete, Art Full Text, CINAHL, MEDLINE, Criminal 

Justice Abstracts with full text and more.. 
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Click on the blue folder icon with the + to select each item (ringed). Icon changes yellow to show item is in 

folder as first 2 in list.  

Click ‘Go to folder view’. In Folder View screen, select all items and click ‘Export’. 

In next screen choose default option ‘Direct Export in RIS Format (e.g. CITAVI, EasyBib, EndNote, ProCite, 

Reference Manager, Zotero), then click ‘Save’. Again, RIS file downloads ready to add to Mendeley as 

above. 

Exporting from Proquest Central 

Once logged in as LJMU using A-Z instructions you may click ‘Change Databases’ to access a list and add 

futher databases to your search. Once chosen, click ‘use selected databases’ then perform a search.  

In results, tick box at top left of each result you wish to select, then click on ‘Cite’ icon. 

 

Ignore everything in next box, but click RIS button at bottom left (pictured). In the next screen RIS is already 

selected and you just need to click ‘Continue’ at the bottom, and the RIS file will download. 
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Adding webpages and other online items using the ‘Web Importer’. 

 

Websites and other online items can be captured using the Web Importer. 

• Open required Web page in Chrome browser then click on the Web Importer extension (explained 

on P3). 

• If not already signed into Mendeley online click on ‘Get Started’ then sign in.   

• Use ringed drop-down to choose a specific folder to save in if desired. 

• If the PDF option is present, keep PDF ticked if desired. 

• Hover over the reference to see ‘Edit Reference’ as pictured then click.  

 

• Make any changes that are needed to ensure your reference would display correctly as in the 

example below. 

• In this example the year was found at the bottom of the webpage and needed adding in the year 

field which was empty. The author ‘Equality and Human Rights Commission’ needed to be cut from 

the Title field and added to the author field. The organisation was the only author on the page in 

this case. 

 

After you click the blue ‘Add’ button pictured above, this shows that your 

reference has been added to Mendeley online.  

 

 

 

 

Tip. SYNC - When you next open Mendeley Desktop, remember to sync to so that these items you have 

added online appear in Mendeley Desktop.  Sync will also update any changes you have made on Mendeley 

Desktop on other computers.  
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Adding an eBook reference with the Web Importer from an eBook landing page 

 

EBook main pages usually work well with the Web Importer, and the material type selects automatically. 

This example is a book from LJMU Ebook Central collection.  

‘Capturing’ the reference in this way whilst accessing the book is an alternative to downloading the 

reference from ‘Discover’ to import. 

Note in this instance, there are three options captured– the 1st is a book reference and is the useful one, 

the 2nd a chapter reference, the 3rd a webpage version.  

Hover over the first option to see ‘edit reference’ as pictured and click to open. Details can be checked and 

edited here, a useful time whilst the book details are on the screen to paste in.  

In this case, publisher details were missing and publisher name and city were added to those fields. 

Note that you can use the drop-down to choose a Mendeley folder to send it to.  

 

Once the details are correct, tick the reference you wish to import as below, and the ‘Add’ button turns 

blue ready for you to click to send the reference to your library. 

 

Tip: Recently Added Folder - If you forget to choose a folder, new documents show in the Recently Added 

Folder in Mendeley Desktop, and can be dragged from there to desired folder.  
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Adding a Journal Article from a Database using the Web Importer 

 

This one is a ‘ProQuest’ Journal Article which has been opened. Click the Web importer, choose folder using 

the dropdown if desired.  Many will import ready to reference accurately in your footnotes. 

 

The first reference is the desired one again, and this time it is possible to bring in a full text PDF if desired. 

Above the box is ticked to add PDF if available. 

Hover and click to ‘Edit Reference’. In this case the Material type was incorrect and needed changing to 

‘Journal article’. Other details had all been completed. This time the reference was ticked to be added 

without editing first by clicking the ‘Add’ button to check and edit later in Mendeley Desktop, as shown in 

the section Checking References . 

Adding a Reference Manually 

On occasion, you may wish to add a reference by typing or pasting in all the details manually.  

For example, you may have a book from your bookshelf. You can just enter the reference details formatted 

as in the links mentioned immediately above. Any material type can be added manually. 

Choose the ‘Add Entry Manually’ option from the drop-down. 

Select the correct material type. 

Type or paste in the details needed for the reference.  

 

 

 

 

 

 

TIP: Don’t forget that an Organisation author will need a comma at the end to display correctly.  
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Checking References and Managing Duplicates 

Checking - It is good practice to check/edit references immediately after adding, so they are ready to use. 

Pictured below the folder ‘Recently Added’ is selected. Using ‘View’ as shown, change Mendeley desktop 

from the usual view - ‘Library as Table’ to show ‘Library as Citations’.  

Select each reference and make any necessary edits to the fields in the right hand pane. Useful to click on 

‘Details are correct’ at top of right hand pane when you have finished checking each one. 

 

You can swap back to the normal table view once you have finished editing. 

Duplicates 

Importing from a number of resources may result in duplicate references. A simple tool helps manage 

these. In the ‘Tools’ menu, select ‘Check for Duplicates’ 

 

Duplicates will be listed. Select each one by one. If the details have no conflicts, you can simply click a 

button to Confirm Merge, and it will go out of the list. 

If there are conflicts where details are different, go to the right hand pane, and tick any boxes which are 

unticked that have details you wish to keep (Instructions are on screen for this) then ‘Confirm Merge’.  

Useful Blog Post on Duplicate Checking in case useful. 

https://blog.mendeley.com/2012/03/26/how-to-series-how-to-check-for-duplicate-entries-and-merging-part-4-of-12/
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Use Mendeley References in your Writing in Microsoft Word 

• In Microsoft Word, insert your cursor where you want the citation. 

• Click Insert Citation 

 

This box pops up – Click on ‘Go To Mendeley’ 

 

The Cite button is now showing in Mendeley desktop. Click on a reference first to select, then click Cite. 

 

The author/date citation will now show in your document. 

Citation Editing 

Editing ‘in-text’ citation (author, year)  

Click on the citation (which will highlight grey).  

Click again where edit is required and make required 

edits such as adding a page number, or using the author 

name as part of your sentence  

e.g. Wong (2016, p23) claims that… 

 

Click elsewhere on the page to pop this box up. Select ‘Keep Manual Edit’ to save your edits. 

Citation edits only apply to 

one. Other citations of the 

same source are 

unchanged. 

NB. Any edits to the source 

details fields should be 

done in the reference 

‘Details’ pane in Mendeley.  
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Adding a PDF to a Reference 

If desired to add a PDF to a reference, first download the PDF required. 

Select the reference so that you can see all the fields in the right hand pane.  

Click on ‘Add File..’ in the ‘Files’ field. Browse to the required PDF, select and click to confirm, 

   It will then show as added as in the example below. 

 

Tip: Free account space is 2G. PDFs use more space than just references so bear this in mind, but a good 

many can be stored in this space. References alone use less space. You could always remove some PDFs 

and references that are no longer needed if this became a problem. 

 

Google Scholar 

Google scholar can export Harvard and some other referencing styles to 

Mendeley. Click on the Cite icon for the item. To open the Cite box as 

below. 

Click Harvard version to highlight in blue if desired, then ‘RefMan’ or go 

straight to ‘Refman’ is fine. RIS file suitable for Mendeley will download. 
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Annotating your library PDFs 

Single clicking on a reference in your library selects it and displays the details in the right hand pane. 

Double clicking opens any attached PDF in a new tab as below ready to read.  

As seen below, a set of useful buttons arrive suitable for highlighting text, adding notes etc.. 

Also in the details pane are found: 

• a Notes tab which displays any previously added notes for the document 

• a Contents tab which displays the document’s ‘Table of contents’ (if it has one – many PDFs do) for 

easy navigation between sections 

You can use the ‘My Library’ tab to swap back to your library at any time. Mendeley automatically saves 

any changes you have made. Click the x on the open document tab if you have finished with it. 
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Inserting a ‘Reference List’ in Microsoft Word 

Decide where you want to insert your Bibliography and leave your cursor there.  

In the Word References tab click on  in the Mendeley plugin. Example below. 

If you have been checking references as you have added them using Checking References , there should be 

no problems. 

You can include eJournal and eBook links in your reference if desired (Mendeley imports these). In the 

examples below some include it and some do not. You would need to delete the link from the record in 

Mendeley if you do not want to include it. If the print details (volume, issue and page details) are present, it 

may be unnecessary. Either is usually acceptable, but it is recommended to be consistent in your approach. 

 

  

The Reference List 

You can continue to add citations to your work and the list will update placing new items correctly 

alphabetically. 

If you decide to remove a citation this is done by deleting the citation in the text. 

Check that item has gone from the Bibliography. Remove it if not.  

 

Always check your module guidance provided by your tutors who will be marking your work for information 

in case there is specific information about reference lists and formats of references. 
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Further Help and Support 

This document is intended to get you started with using Mendeley importing references and documents 

from the web and the LJMU electronic library. 

 

The software has many other features such as Researcher Networking, Search, Groups and ‘Suggest’. 

 

Visit https://www.mendeley.com/guides for information about these features and for further detail on 

using the software. 

 

For support with Mendeley please either contact named librarian or use the methods below: 

• the LJMU HelpMe form 

• Library Chat 

 

Maria Hardie (Wed-Thurs-Friday) m.c.hardie@ljmu.ac.uk  
    

     

You are welcome to contact us for further help, and to arrange a one-to-one appointment. 

Guide Updated: September 2021  

By: M Hardie 

 

 

          

 

 

https://www.mendeley.com/guides
https://helpme.ljmu.ac.uk/
https://region-eu.libanswers.com/chati.php?hash=dc6c38de63ca22b3752d4c49a3eb683f&referer=https%3A%2F%2Fwww.ljmu.ac.uk%2Fmicrosites%2Flibrary%2Fabout-ljmu-libraries%2Fcontact-us&referer_title=Contact%20Us%20%7C%20Liverpool%20John%20Moores%20University
mailto:m.c.hardie@ljmu.ac.uk

